
PHAÀN MEÀM GPS TrackMaker

TOÅNG QUAÙT

Phaàn meàm GPS TrackMaker (trong taøi lieäu naøy seõ goïi taét laø TrackMaker) do moät taùc
giaû ngöôøi Brazil coù teân laø Odilon Ferreira Juùninor vieát. Phieân baûn ñöôïc giôùi thieäu trong taøi
lieäu naøy laø Version #12.0, phieân baûn môùi nhaát ñöôïc taûi töø trang web www.gpstm.com.
Ñaây laø phieân baûn mieãn phí. Neáu so vôùi GarFile, moät phaàn meàm raát ñôn giaûn chæ cho pheùp
taûi xuoáng/leân toaï ñoä vaø ñöôøng ñi töø maùy ñònh vò Garmin roài môû ra trong MapInfo, thì
TrackMaker laø moät phaàn meàm maïnh coù nhieàu chöùc naêng lyù thuù. Phaàn meàm naøy thaäm chí
coøn cho pheùp ñöa moät aûnh queùt vaø ñaêng kyù toaï ñoä cho noù hieån thò ñöôïc leân maøn hình.
TrackMaker hoaït ñoäng ñöôïc treân haàu heát caùc loaïi maùy ñònh vò phoå bieán hieän nay.

Chuù yù: Taøi lieäu naøy chæ höôùng daãn söû duïng nhöõng chöùc naêng quan troïng nhaát cuûa
TrackMaker, chuû yeáu lieân quan ñeán vieäc chuyeån ñoåi döõ lieäu giöõa maùy ñònh vò vaø phaàn meàm
naøy. Caùc chöùc naêng coøn laïi, ngöôøi ñoïc coù theå töï tìm hieåu vaø söû duïng.

Caøi ñaët TrackMaker

Sau khi taûi taäp tin gtm120.exe veà, thöïc hieän caøi ñaët nhö sau:

- Choïn taäp tin naøy vaø nhaán phím <Enter>. Hoäp thoaïi GPS TrackMaker InstallShield
Wizard hieän ra.

- Choïn Next. Hoäp thoaïi Destination Folder hieän ra. Thö muïc caøi ñaët maëc ñònh laø
\Program Files\TrackMaker. Neáu muoán thay ñoåi thö muïc caøi ñaët chöông trình, nhaép
chuoät vaøo nuùt Change vaø choïn thö muïc caøi ñaët khaùc.

- Choïn Next. Hoäp thoaïi Ready to Install Program hieän ra, cho ta kieåm tra laïi caùc thoâng
soá caøi ñaët. Neáu khoâng öng yù ta nhaép chuoät vaøo nuùt Back ñeå quay laïi maøn hình tröôùc;
neáu öng yù vôùi caùc thoâng soá caøi ñaët ñaõ choïn, ta nhaép chuoät vaøo nuùt Install.

Chöông trình baét ñaàu tieán haønh caøi ñaët. Sau khi caøi ñaët xong, hoäp thoaïi InstallShield



Wizard Completed hieän leân, thoâng baùo quaù trình caøi ñaët hoaøn taát.

Muïc Launch the Program ñöôïc ñaùnh daáu theo maëc ñònh. Neáu giöõ nguyeân tuyø choïn naøy
vaø nhaép chuoät vaøo nuùt Finish (keát thuùc) thì trình caøi ñaët keát thuùc vaø chöông trình
TrackMaker ñöôïc khôûi ñoäng. Neáu khoâng muoán khôûi ñoäng chöông trình sau khi caøi ñaët, ta
taét choïn trong muïc naøy ñi roài nhaép chuoät choïn Finish.

Ñeå khôûi ñoäng chöông trình, ta vaøo menu START cuûa heä ñieàu haønh, choïn Programs >
GPS TrackMaker > GPS TrackMaker, chöông trình seõ ñöôïc khôûi ñoäng.

GIAO DIEÄN CUÛA CHÖÔNG TRÌNH

Maøn hình cuûa khi khôûi ñoäng cuûa TrackMaker ñöôïc trình baøy treân hình. Treân menu
chính coù caùc noäi dung File, Edit,  View, Tools, Interface, Help.

Menu File

Goàm coù caùc muïc sau:

- New File: Taïo moät taäp tin môùi.

- Open File: môû moät taäp tin ñaõ löu.

- Merge File: nhaäp moät taäp tin vaøo moät taäp tin ñang môû.

- Save File: löu nhöõng thay ñoåi treân taäp tin ñang môû.

- Save File as: löu moät taäp tin ñang môû thaønh moät taäp tin môùi.

Hình 1. Giao dieän cuûa chöông trình GPS TrackMaker.



- Print: in baûn ñoà trình baøy treân
maøn hình.

- Exit: thoaùt khoûi chöông trình.

Phía treân leänh Exit laø phaàn
hieån thò caùc taäp tin ñaõ môû tröôùc
ñoù.

Menu Edit

Menu naøy goàm coù caùc noäi dung sau:

- Undo: huyû leänh ñaõ thöïc hieän tröôùc ñoù.

- Delete: Xoaù ñoái töôïng ñang ñöôïc choïn.

- Cut: Xoaù ñoái töôïng ñang ñöôïc choïn vaø ñöa vaøo boä nhôù taïm.

- Copy: Cheùp laïi ñoái töôïng ñang ñöôïc choïn.

- Paste: Daùn ñoái töôïng töø boä nhôù taïm.

- Paste Image: daùn hình aûnh.

- Select All: Choïn taát caû caùc ñoái töôïng.

- Find: Tìm kieám.

- Replace: Thay theá.

Menu View

Menu naøy goàm caùc tuyø choïn kieåm soaùt cheá ñoä hieån thò cuûa baûn ñoà, goàm coù caùc noäi
dung sau:

- Zoom In: Phoùng to baûn ñoà.

- Zoom Out: thu nhoû baûn ñoà.

- General View: xem toång quaùt toaøn boä noäi dung treân baûn
ñoà ñang môû.

- Magnify: choïn nuùt coâng cuï phoùng to/thu nhoû.

- Waypoints: hieån thò caùc ñieåm toaï ñoä (maëc ñònh ñöôïc
ñaùnh daáu).

- Tracklogs: hieån thò caùc ñöôøng ñi (maëc ñònh taét).

- Show Tracks by Colors: hieån thò caùc ñöôøng ñi vôùi caùc
maøu khaùc nhau (moãi ñöôøng ñi coù moät maøu).

- Routes: hieån thò caùc loä trình (maëc ñònh ñöôïc ñaùnh daáu).

- Waypoint Text: Hieån thò nhaõn cuûa caùc ñieåm toaï ñoä
(maëc ñònh ñöôïc ñaùnh daáu).

- Tracklog Labels: hieån thò nhaõn cuûa caùc ñöôøng ñi (maëc ñònh ñöôïc ñaùnh daáu).

Hình 3. Menu Edit.

Hình 4. Menu View.

Hình 2. Menu File.



- Grid: hieån thò löôùi toaï ñoä (maëc ñònh ñöôïc ñaùnh daáu).

- Scale: hieån thò tyû leä cuûa baûn ñoà ôû goùc döôùi beân traùi (maëc ñònh ñöôïc ñaùnh daáu).

- Altitude Profile: hieån thò maët caét ñoä cao (maëc ñònh taét).

- Report Window: hieån thò cöûa soå thoâng baùo thoâng tin (maëc ñònh taét).

- Toolbars: choïn caùc thanh coâng cuï. Khi nhaép chuoät vaøo muïc naøy, menu phuï môû ra hieån
thò teân 3 thanh coâng cuï. Theo maëc ñònh, 3 thanh coâng cuï naøy ñeàu ñöôïc baät leân:

+ Main: thanh coâng cuï chính cuûa chöông trình.

+ Search: thanh coâng cuï coù caùc leänh tìm kieám.

+ Draw: thanh coâng cuï coù caùc nuùt leänh ñeå veõ caùc ñoái töôïng leân baûn ñoà.

- Status Bar: hieån thò thanh traïng thaùi, theo maëc ñònh thanh traïng thaùi ñöôïc ñaùnh
daáu (baät leân).

Menu Tools

Menu naøy goàm caùc nuùt leänh coâng cuï chính cuûa chöông trình, bao goàm
caùc leänh sau:

- Waypoints: khi choïn leänh naøy, moät menu
con môû ra goàm coù caùc leänh sau:

+ Select Wpts by Symbol: choïn caùc ñieåm
toaï ñoä theo bieåu töôïng.

+ Change Selected Wpts: thay ñoåi caùc
ñieåm toaï ñoä ñang ñöôïc choïn.

+ Repeated Wpt Tool: chöùc naêng tìm caùc
ñieåm toaï ñoä bò truøng.

+ Waypoint Styles: ñònh daïng kieåu cuûa caùc
ñieåm toaï ñoä.

- Tracklogs/Routes: khi choïn leänh naøy, menu con môû ra goàm caùc leänh sau:

Hình 8. Thanh traïng thaùi (Status Bar)

H
ình 7 . Thanh coâng cuï D
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Hình 6. Thanh coâng
cuï Search

Hình 5. Thanh
coâng cuï Main

Hình 9. Menu Tools



+ Fragment Tracklogs: caùc ñöôøng ñi bò ñöùt ñoaïn.

+ Select Tracklogs by Styles: choïn caùc ñöôøng ñi
theo kieåu.

+ Select Repeated Tracklogs/Routes: choïn caùc
ñöôøng ñi/loä trình bò laëp.

+ Change Tracklog Style: thay ñoåi kieåu ñöôøng ñi.

+ Tracklog Reducer: ruùt goïn ñöôøng
ñi.

+ Reverse Tracklog/Route: ñaûo chieàu
ñöôøng ñi/loä trình.

+ Tracklogs Speeds: baùo toác ñoä di
chuyeån cuûa treân ñöôøng ñi.

- Invert Selected Points: ñaûo ngöôïc pheùp
choïn caùc ñieåm.

- Snap: chöùc naêng “caén ñieåm”, maëc ñònh ñöôïc baät leân.

- Pencil: nuùt leänh veõ.

- Cartographic Length: hieån thò khoaûng caùch khi reâ chuoät treân baûn ñoà.

- Insert Image Map: cheøn moät baûn ñoà daïng aûnh queùt vaøo.

- Autoload Catalog: môû hoäp thoaïi lieät keâ danh saùch caùc aûnh queùt ñöôïc naïp töï ñoäng khi
môû baûn ñoà.

- Select Wpts far from Routes: choïn caùc ñieåm naèm caùch xa caùc loä trình.

- Options: môû hoäp thoaïi ñieàu chænh caùc tuyø choïn cuûa chöông trình.

Menu Interface

Menu naøy cho pheùp ta choïn giao dieän ñoái vôùi caùc loaïi maùy ñònh vò khaùc nhau, noù goàm
coù caùc muïc sau:

- Garmin Interface: Giao dieän cho caùc loaïi maùy
ñònh vò cuûa haõng Garmin.

- Lowrance/Eagle Interface: giao dieän cho caùc
loaïi maùy ñònh vò cuûa haõng Lowrance/Eagle.

- Magellan Interface: giao dieän cho caùc loaïi maùy
ñònh vò cuûa haõng Magellan.

- MLR Interface: giao dieän cho caùc maùy ñònh vò
cuûa haõng MLR.

- Brunton/Silva Interface: giao dieän cho caùc loaïi maùy ñònh vò cuûa haõng Brunton/Silva.

- NMEA 0183: giao dieän tieâu chuaån chung cho caùc loaïi maùy ñònh vò.

Hình 11. Menu phuï 
Tracklogs/Routes.

Hình 12. Menu Interface.

Hình 10. Menu phuï
Waypoint.



- GTM Tracker: giao dieän maùy ñònh vò GTM Tracker.

- Simulation: giao dieän moâ phoûng (khoâng theo moät chuaån cuûa haõng naøo). Khi choïn muïc
naøy, chöông trình seõ môû ra hai cöûa soå. Moät cöûa soå hieån thò caùc thoâng tin veà toaï ñoä, toác
ñoä, ñoä cao,... Cöûa soå kia hieån thò maët caét ñòa hình khi maùy ñònh vò di chuyeån. Treân cöûa
soå baûn ñoà hieän leân moät con chaïy. Khi con chaïy di chuyeån, caùc thoâng tin treân hai cöûa
soå thay ñoåi töông öùng. Leänh naøy thöïc chaát moâ phoûng laïi caùc thoâng tin hieän leân treân moät
maùy ñònh vò khi ta di chuyeån.

Menu Help

Menu naøy goàm caùc noäi dung giuùp ñôõ, bao goàm:

- Contents: môû noäi dung giuùp ñôõ. Tuy nhieân phaàn
höôùng daãn cuûa chöông trình naøy khoâng ñöôïc tích hôïp
vaøo phaàn meàm. Ngöôøi ñoïc muoán xem phaûi vaøo trang
web cuûa chöông trình GTM ñeå xem phaàn giuùp ñôõ.

- GPS TrackMaker Home Page: lieân keát vaøo trang web
cuûa phaàn meàm naøy.

- Language: choïn ngoân ngöõ cho chöông trình, goàm coù English (tieáng Anh), Portuguese
(tieáng Boà Ñaøo Nha) vaø Spanish (tieáng Taây Ban Nha). Khi thay ñoåi ngoân ngöõ, moät hoäp
thoaïi (hình) hieän ra, thoâng baùo raèng ta phaûi taét roài khôûi ñoäng laïi chöông trình thì môùi
coù theå ñoåi ngoân ngöõ ñöôïc.

- About GPS TrackMaker:
giôùi thieäu veà taùc giaû vaø
phaàn meàm naøy.

Ñieàu chænh caùc thieát
laäp

Phaàn ñieàu chænh caùc
thieát laäp cuûa chöông trình GPS TrackMaker naèm trong phaàn Tools > Options. Khi choïn
muïc naøy, hoäp thoaïi GPS TrackMaker Options môû ra (hình). Trong hoäp thoaïi naøy coù caùc theû
(tab) khaùc nhau, ta nhaép chuoät vaøo töøng theû ñeå vaøo hoäp thoaïi chænh thieát laäp töøng muïc.
Hoäp thoaïi naøy goàm coù caùc noäi dung sau:

General

Hoäp thoaïi naøy duøng ñeå ñieàu chænh caùc thieát laäp chung cuûa chöông trình, bao goàm:

Behavior

Phaàn naøy goàm caùc tuyø choïn veà “phaûn öùng” cuûa chöông trình tröôùc caùc leänh.

- Ask about track/route Union: hoûi laïi khi nhaäp ñöôøng ñi/loä trình.

- Ask about wpt/tracks deletion: hoûi laïi tröôùc khi xoaù ñieåm/ñöôøng ñi.

Hình 13. Menu Help.

Hình 14. Thoâng baùo khôûi ñoäng laïi chöông trình khi
thay ñoåi ngoân ngöõ.



- Increase line width on map: taêng chieàu roäng cuûa ñöôøng.

- Zoom with mouse wheel: phoùng to/thu nhoû baèng baùnh xe treân chuoät coù baùnh xe.

Theo maëc ñònh, taát caû caùc tuyø choïn naøy ñeàu ñöôïc baät leân.

User Default

Phaàn naøy duøng ñeå choïn cheá ñoä maëc
ñònh veà ñieåm vaø ñöôøng ñi do ngöôøi duøng
ñònh nghóa, goàm 2 muïc:

- Waypoint: khi nhaép chuoät vaøo nuùt
naøy, hoäp thoaïi Waypoint Default
(hình) môû ra. Hoäp thoaïi naøy cho pheùp
ta choïn bieåu töôïng maëc ñònh cho caùc
ñieåm. Treân hoäp thoaïi naøy coù caùc kieåu
bieåu töôïng cuûa caùc loaïi maùy ñònh vò
cuûa caùc haõng phoå bieán nhaát. Ta nhaép
chuoät vaøo töøng tab ñeå vaøo boä bieåu
töôïng cuûa töøng haõng vaø choïn kieåu bieåu
töôïng maëc ñònh. Tab All hieån thò taát
caû caùc bieåu töôïng coù trong chöông
trình. Nuùt Waypoint Default seõ laáy
caùc thieát laäp ta choïn laøm thieát laäp
maëc ñònh cho ñieåm. Neáu ta choïn moät
kieåu bieåu töôïng naøo ñoù roài nhaép chuoät

Hình 15. 
Hoäp thoaïi GPS
TrackMaker
Options - General

Hình 16. Hoäp thoaïi Waypoint Default.



vaøo nuùt Set as Default thì kieåu bieåu töôïng ñoù
ñöôïc choïn laø maëc ñònh. Nuùt Edit Waypoint Style
môû hoäp thoaïi Waypoint Style chænh kieåu chöõ,
cheá ñoä hieån thò,... cuûa bieåu töôïng.

- Tracklog: môû hoäp thoaïi Select Tracklog Style
(hình) ñeå choïn kieåu ñöôøng. Nhaép chuoät vaøo töøng
muïc General hay Lines ñeå choïn kieåu ñöôøng.
Muïc Polygons cho pheùp ta choïn kieåu vuøng.

Comm Port

Phaàn naøy cho pheùp ta choïn coång COM keát noái
vôùi maùy ñònh vò. Ta coù theå choïn caùc coång COM töø 1
ñeán 12. Neáu khoâng bieát maùy ñònh vò ñang ñöôïc caém
vaøo coång naøo, ta coù theå nhaép chuoät vaøo nuùt Auto-
Detection ñeå cho chöông trình kieåm tra vaø choïn
coång COM cho ta. Maùy ñònh vò phaûi ñöôïc noái vaøo
maùy tính vaø ñöôïc baät leân tröôùc ñoù.

Colors

Phaàn naøy coù hai muïc laø Grid vaø Background. Nhaép chuoät vaøo nuùt Grid ñeå choïn maøu
cho löôùi toaï ñoä, nhaép chuoät vaøo nuùt Background ñeå choïn maøu neàn cho baûn ñoà.

Fonts

Phaàn cho pheùp ta choïn kieåu chöõ cho caùc ñieåm toaï ñoä (nuùt Wpt Styles), kieåu chöõ cho
nhaõn löôùi toaï ñoä (nuùt Grid) vaø kieåu chöõ cho nhaõn cuûa ñöôøng ñi (nuùt Track Labels).

Show Data Properties

Phaàn naøy coù moät nuùt leänh laø Configure (caáu hình). Nuùt leänh naøy môû ra moät hoäp thoaïi
(hình), cho pheùp ta choïn caùc noäi dung seõ ñöôïc hieån thò khi di chuyeån con troû chuoät laïi gaàn
ñieåm (phaàn Waypoints beân traùi) hay ñöôøng ñi/loä trình (phaàn Tracklogs/Routes beân phaûi).
Muoán hieån thò noäi dung naøo, ta ñaùnh daáu vaøo noäi dung ñoù.

Ñoái vôùi ñieåm, ta coù theå hieån thò caùc noäi dung sau:

- Name/Comments: teân ñieåm vaø chuù thích.

- Coordinates: toaï ñoä.

- Altitude: ñoä cao.

- Date: ngaøy thaùng.

- Angle of Rotation: (goùc quay - neáu ñieåm ñoù ñaõ ñöôïc quay ñi moät goùc).

- Style Number: soá hieäu kieåu.

- Icon Number: soá hieäu cuûa bieåu töôïng.

Ñoái vôùi caùc ñöôøng ñi/loä trình, ta coù theå hieån thò caùc thoâng tin sau:

Hình 17. Hoäp thoaïi Select
Tracklog  Style.



- Tracklog/Route Name: teân ñöôøng ñi hay loä trình.

- Bearing arrow: muõi teân chæ höôùng cuûa ñöôøng.

- Bearing Angle: goùc cuûa ñöôøng ñi

- Tracklog/Route Number: soá thöù töï cuûa ñöôøng ñi/loä trình.

- Segment Number: soá löôïng ñoaïn treân ñöôøng/loä trình ñoù.

- Total of Points: toång soá ñieåm (noát) cuûa ñöôøng ñoù.

- Segment Length: chieàu daøi cuûa ñoaïn.

- Average Altitude of Segment: Chieàu cao trung bình cuûa ñoaïn.

- Segment Speed: toác ñoä di chuyeån treân ñoaïn ñoù.

- Average Speed: toác ñoä trung bình treân ñöôøng ñi ñoù.

- Time Interval of Segment: khoaûng thôøi gian giöõa caùc ñoaïn.

- Total Time Interval: toång thôøi gian cuûa ñöôøng ñi ñoù.

- Date of Segment: ngaøy thaùng cuûa ñoaïn ñoù.

- Start Date: ngaøy baét ñaàu.

- End Date: ngaøy keát thuùc.

Goùc treân beân traùi hoäp thoaïi naøy coù tuyø choïn Show Properties. Neáu ta taét choïn muïc
naøy thì taát caû caùc noäi dung seõ bò môø ñi, coù nghóa laø khi di chuyeån chuoät ñeán gaàn moät ñieåm
hay moät ñöôøng naøo ñoù, khoâng coù thoâng tin naøo hieån thò treân ñaàu con troû chuoät caû.

General Reset
Phaàn naøy coù moät nuùt leänh laø Reset. Neáu ta nhaép chuoät vaøo nuùt naøy thì moät hoäp thoaïi

môû ra (hình). Hoäp thoaïi naøy hoûi ta coù muoán traû taát caû caùc thieát laäp trong hoäp thoaïi Options
veà cheá ñoä maëc ñònh hay khoâng. Neáu ta choïn Yes, taát caû caùc thieát laäp seõ ñöôïc traû veà cheá

Hình 18. Hoäp thoaïi choïn thoâng tin hieån thò khi di chuyeån chuoät laïi gaàn ñoái töôïng.



ñoä maëc ñònh, gioáng nhö khi môùi caøi ñaët
chöông trình.

Units

Hoäp thoaïi naøy cho pheùp ta choïn ñôn
vò ño chieàu daøi (oâ Length Units) vaø ñoä cao
(oâ Altitude). Phaàn Time cho pheùp ta choïn
muùi giôø trong oâ Local Time Zone. Nöôùc ta
naèm trong muùi soá 7. Giôø hieån thò trong oâ
Local Time laø giôø ñòa phöông cuûa ta. OÂ UTC Time hieån thò giôø quoác teá (giôø GMT).

Coordinates

Phaàn naøy cho pheùp ta choïn heä toaï ñoä. Neáu choïn theo kinh ñoä/vó ñoä ta coù 3 tuyø choïn
laø Deg (ñoä thaäp phaân), Deg/Min (ñoä vaø phuùt thaäp phaân) vaø Deg/Min/Sec (ñoä-phuùt-giaây).
Ta cuõng coù theå choïn heä toaï ñoä theo caùc löôùi chöõ nhaät trong phaàn Rectangular Grids. Neáu
choïn phaàn naøy, ta seõ phaûi choïn moät trong caùc heä toaï ñoä ôû oâ döôùi. Heä toaï ñoä thuoäc nhoùm
naøy thöôøng söû duïng ôû nöôùc ta laø UTM (Universal Transverse Mercator).

Images

Images cho pheùp choïn cheá ñoä cuûa aûnh queùt khi hieån thò treân baûn ñoà. Coù 3 tuyø choïn:

- Hide Raster images when dragging: ñaùnh daáu vaøo tuyø choïn naøy seõ taét aûnh queùt khi keùo
baûn ñoà.

Hình 20. 
Hoäp thoaïi GPS
TrackMaker
Options - Units.

Hình 19. Hoäp thoaïi hoûi khaúng ñònh traû
caùc thieát laäp veà giaù trò maëc ñònh.



- Hide Metafile images when dragging: laø tuyø choïn töông töï aûnh queùt nhöng aùp duïng
cho aûnh Metafile.

- Save images in TXT files: löu aûnh ôû daïng taäp tin TXT (vaên baûn).

Hình 21. Hoäp thoaïi GPS TrackMaker Options - Coordinates.

Hình 22. Hoäp thoaïi GPS TrackMaker Options - Images.



Printer

Ñaây laø phaàn ñieàu chænh caùc thieát laäp in aán.

Hai thanh tröôït ngang vaø doïc cho pheùp ta ñieàu chænh ñoä co daõn cuûa aûnh in ra theo
chieàu ngang (Horizontal Deformation) vaø chieàu ñöùng (Vertical Deformation).

Tuyø choïn Print in Scale (maëc ñònh ñöôïc baät leân) seõ in baûn ñoà ra theo ñuùng tyû leä ngang
vaø doïc (khoâng co daõn).

Profile

Phaàn laø caùc ñieàu chænh lieân quan ñeå bieåu dieãn phaàn maët caét (ñoä cao) treân baûn ñoà.

Neáu ñaùnh daáu vaøo Use Predefined Color, ta coù theå ñieàu chænh maøu baèng nuùt Profile
Color vaø maøu chöõ baèng nuùt Wpt Text Color.

Phaàn Angle of Text Rotation khai baùo goùc quay chöõ.

Detect Nearest Wpts Until: trong phaàn naøy ta khai baùo khoaûng caùch chöông trình tìm
caùc ñieåm toaï ñoä. Giaù trò maëc ñònh laø 3000 m.

Datum

Phaàn naøy cho pheùp ta choïn moác toaï ñoä (Datum). Moác maëc ñònh laø WGS84 (World
Geodetic System 1984).

Neáu ta ñaùnh daáu vaøo tuyø choïn List of datum supported by GPS thì phía döôùi seõ lieät keâ

Hình 23. Hoäp thoaïi GPS TrackMaker Options - Printer.



danh saùch caùc moác toaï ñoä ñöôïc maùy ñònh vò hoã trôï. Neáu khoâng ñaùnh daáu muïc naøy thì danh
saùch phía döôùi laø caùc heä moác toaï ñoä tieâu chuaån.

Hình 25. Hoäp thoaïi
GPS TrackMaker
Options - Datum.

Hình 24. Hoäp thoaïi
GPS TrackMaker
Options - Profile.



SÖÛ DUÏNG CHÖÔNG TRÌNH

Taûi toaï ñoä vaø ñöôøng ñi/loä trình giöõa maùy ñònh vò vaø maùy tính

Ñeå taûi döõ lieäu töø maùy ñònh vò xuoáng maùy tính, ta thöïc hieän nhö sau:

- Caém maùy ñònh vò vaøo maùy tính qua caùp noái tieáp RS-232 vaø baät maùy ñònh vò leân.

- Choïn Tools > Options vaø choïn coång COM cho ñuùng vôùi coång ñaõ caém maùy ñònh vò trong
phaàn Comm Port. Coù theå ñeå phaàn meàm töï choïn coång COM cho ta baèng caùch nhaép
chuoät vaøo nuùt Auto-Detection. Thöïc hieän xong choïn OK.

- Choïn Interface. Tuyø theo maùy ñònh vò maø ta cho giao dieän cho phuø hôïp, ví duï neáu ta
söû duïng maùy ñònh cuûa haõng Garmin thì ta choïn Garmin Interface, söû duïng maùy
Lowrance thì ta choïn Lowrance/Eagle Interface. Hoäp thoaïi coù daïng [Loaïi maùy ñònh vò]
Interface môû ra. Maëc ñònh nuùt Request from GPS ñöôïc ñaùnh daáu.

- Kieåm tra xem maùy tính ñaõ nhaän ñöôïc maùy ñònh vò chöa baèng caùch nhaép chuoät vaøo nuùt
Product ID.

Neáu maùy tính vaø chöông trình nhaän ñöôïc maùy ñònh vò, model maùy ñònh vò vaø phieân
baûn phaàn meàm chaïy treân maùy seõ hieån thò trong oâ maøu ñen cuûa hoäp thoaïi. Luùc naøy ta coù
theå baét ñaàu tieán haønh taûi döõ lieäu.

Ñeå taûi caùc ñieåm toaï ñoä ñaõ löu trong maùy ñònh vò ta nhaép chuoät vaøo nuùt Waypoints. Ñeå
taûi caùc ñöôøng ñi ta nhaép chuoät vaøo nuùt Tracklogs. Ñeå taûi caùc loä trình ta nhaép chuoät vaøo nuùt
Routes. Moãi laàn nhaép chuoät vaøo moät trong 3 nuùt leänh treân, chöông trình seõ baét ñaàu taûi caùc
thoâng tin thuoäc nhoùm ñoù vaøo maùy tính. 

Ta cuõng coù theå taûi taát caû caùc thoâng tin töø maùy ñònh vò vaøo maùy tính baèng caùch nhaép
chuoät vaøo nuùt All.

Ñeå huyû boû vieäc taûi döõ lieäu giöõa chöøng, ta nhaép chuoät vaøo nuùt Abort, neáu muoán.

Sau khi taûi xong caùc döõ lieäu caàn thieát töø maùy ñònh vò, nhaép chuoät vaøo nuùt Exit ñeå thoaùt
khoûi hoäp thoaïi naøy.

Cöûa soå chính cuûa chöông trình luùc naøy seõ hieån thò caùc thoâng tin ñaõ ñöôïc taûi töø maùy
ñònh vò, caùc ñieåm, caùc ñöôøng ñi vaø loä trình cuõng seõ hieån thò neáu coù taûi.

Ñeå löu caùc thoâng tin naøy laïi, töø menu chính choïn File > Save File. Hoäp thoaïi Save File
môû ra.

Ta coù theå choïn ñònh daïng ñeå löu taäp tin chöùa döõ lieäu toaï ñoä trong oâ Save as Type. Ñònh
daïng chuaån cuûa chöông trình naøy laø GPS TrackMaker file (*.gtm). Tuy nhieân, ñònh daïng
deã daøng trao ñoåi vôùi caùc phaàn meàm khaùc nhaát laø GPS TrackMkaer Text Format (*.txt).
Phaàn meàm naøy cuõng cho pheùp löu caùc döõ lieäu taûi ñöôïc thaønh ñònh daïng cuûa caùc phaàn meàm
khaùc nhö Garmin PCX5 (ñònh daïng cuûa PCX5 duøng cho caùc maùy Garmin), Lowrance MMC
Files (*.usr),...



Ñeå taûi thoâng tin töø baûn ñoà trong chöông trình naøy vaøo maùy ñònh vò, ta thöïc hieän hoaøn
toaøn töông töï, chæ khaùc laø khi choïn leänh Interface, khi hoäp thoaïi Interface môû ra ta phaûi
choïn nuùt Send to GPS.

Ta cuõng coù theå taûi leân nhöõng phaàn ta muoán moät caùch rieâng bieät nhö ñieåm toaï ñoä,
ñöôøng ñi hay loä trình hay taûi toaøn boä moät luùc.

Thao taùc treân baûn ñoà sau khi taûi döõ lieäu

Tuyø theo caùc noäi dung maø ta ñaõ choïn taûi döõ lieäu xuoáng maø treân maøn hình seõ hieän leân
caùc thoâng tin khaùc nhau nhö caùc ñieåm toaï ñoä ñaõ löu, caùc ñöôøng ñi hay loä trình.

Di chuyeån, ñònh vò vaø choïn caùc ñoái töôïng treân baûn ñoà

- Ñeå xem toaøn boä caùc thoâng tin ñaõ ñöôïc taûi vaøo maùy tính, ta choïn View > General View.
Baûn ñoà seõ ñöôïc thu nhoû laïi ñeå hieån thò toaøn boä caùc noäi dung ñaõ ñöôïc taûi vaøo.

- Ñeå di chuyeån baûn ñoà ta giöõ phím chuoät phaûi vaø reâ chuoät, con troû chuoät luùc ñoù bieán
thaønh hình baøn tay.

- Ñeå phoùng to hay thu nhoû baûn ñoà, ta söû duïng hai nuùt phoùng to vaø thu nhoû .

- Ñeå phoùng to moät khu vöïc treân baûn ñoà, ta nhaép chuoät choïn nuùt Zoom , sau ñoù reâ

chuoät treân vuøng caàn phoùng lôùn, phaàn baûn ñoà ñoù seõ ñöôïc phoùng to chieám heát maøn hình.

Nuùt Zoom coøn laø moät leänh taét cuûa menu View. Khi choïn noù vaø di chuyeån con troû chuoät
trôû laïi baûn ñoà, con troû chuoät bieán thaønh hình kính luùp. Khi nhaép chuoät traùi leân baûn ñoà,
toaøn boä menu View seõ môû ra, cho pheùp ta choïn nhanh caùc leänh trong menu naøy.

- Ñeå bieát ñöôïc toaï ñoä taïi vò trí con troû chuoät khi di chuyeån chuoät treân baûn ñoà, ta nhaép

chuoät vaøo nuùt beân traùi muïc Latitude - Longitude treân thanh coâng cuï Search. Khi

ñoù, neáu di chuyeån chuoät treân baûn ñoà hai chöõ Latitude - Longtitude seõ bieán thaønh giaù

trò vó ñoä vaø kinh ñoä taïi vò trí con troû chuoät.

- Ñeå choïn moät ñoái töôïng treân baûn ñoà, tröôùc heát ta phaûi baät chöùc naêng Snap leân baèng caùch

nhaép chuoät vaøo nuùt Snap ñeå laøm cho nuùt naøy saùng leân. Sau ñoù nhaép chuoät choïn

nuùt Select data , di chuyeån chuoät trôû laïi baûn ñoà vaø nhaép chuoät leân ñieåm hay ñöôøng

caàn choïn. Khi di chuyeån chuoät ñeán gaàn moät

ñieåm, chöùc naêng Snap seõ laøm cho ñieåm ñoù ñöôïc

ñaùnh daáu baèng moät hình troøn bao quanh ñoàng

thôøi thoâng tin trong tröôøng Description (xem tieáp phaàn sau) cuõng hieän leân cho ta bieát

theâm thoâng tin veà ñieåm ñoù. Neáu ta nhaép chuoät thì ñieåm ñoù ñöôïc choïn, ñieåm ñöôïc choïn

ñöôïc ñaùnh daáu baèng moät hình vuoâng bao quanh. Ñeå choïn nhieàu ñoái töôïng, ta giöõ phím



<Shift> trong khi nhaép chuoät leân caùc

ñoái töôïng. Ta cuõng coù theå choïn nhieàu

ñoái töôïng treân moät vuøng baèng caùch

choïn nuùt Select data roài reâ chuoät leân

vuøng caàn choïn.

Khi nhaép chuoät choïn loä trình hay
ñöôøng ñi thì chæ coù moät ñoaïn (ñoaïn thaúng
giöõa hai ñieåm toaï ñoä) ñöôïc choïn vaø noù
ñöôïc ñaùnh daáu baèng caùch bò ñoåi maøu
ñoàng thôøi trung ñieåm cuûa ñoaïn ñoù ñöôïc ñaùnh daáu baèng moät chaám troøn maøu ñoû. Neáu nhaép
chuoät ñuùp leân ñöôøng ñi/loä trình thì trung ñieåm cuûa caùc ñoaïn seõ ñöôïc ñaùnh daáu baèng caùc
chaám maøu ñoû vaø toaøn boä ñöôøng ñi/loä trình ñoù ñöôïc choïn.

Moät trong nhöõng öu ñieåm cuûa GPS TrackMaker laø noù nhaän ñöôïc taát caû caùc kieåu bieåu

töôïng cuûa caùc loaïi maùy ñònh vò phoå bieán nhaát hieän nay. Do vaäy ta coù theå choïn caùc ñieåm

toaï ñoä theo bieåu töôïng cuûa chuùng. Neáu muoán choïn theo bieåu töôïng, ta choïn Tools >

Waypoints >  Select Wpts by Symbol hay choïn nhanh baèng caùch nhaép chuoät choïn nuùt

treân thanh coâng cuï Main. Hoäp thoaïi Select Waypoints by Symbol môû ra (hình). Hoäp

thoaïi naøy lieät keâ taát caû caùc kieåu bieåu töôïng coù treân baûn ñoà. Ta chæ vieäc choïn kieåu bieåu töôïng

roài nhaép chuoät vaøo nuùt OK laø taát caû caùc ñieåm coù kieåu  bieåu töôïng ñoù seõ ñöôïc choïn.

Töông töï nhö vaäy, ta coù theå choïn caùc ñöôøng ñi theo kieåu cuûa chuùng baèng leänh Tools >

Tracklogs/Routes > Select Tracklogs by Styles hay nuùt leänh .

Ta coù theå hieån thò hay taét caùc noäi dung treân baûn ñoà baèng caùc tuyø choïn trong menu
View (xin xem laïi chi tieát menu naøy ôû phaàn tröôùc).

Xem thoâng tin cuûa baûn ñoà

Xem thoâng tin cuûa ñieåm

Ñeå xem thoâng tin cuûa moät ñieåm toaï ñoä, ta thöïc hieän nhö sau:

- Baät chöùc naêng Snap leân, sau ñoù choïn nuùt Select Data.

- Di chuyeån chuoät laïi gaàn ñieåm muoán choïn, ñieåm ñoù seõ ñöôïc ñaùnh daáu.

- Nhaép chuoät phaûi, hoäp thoaïi Edit Waypoint (hình) seõ môû ra, cho ta bieát thoâng tin cuûa
ñieåm ñöôïc choïn. Ta coù theå chænh söûa caùc thoâng tin naøy.

Hoäp thoaïi naøy coù caùc noäi dung nhö sau:

- Nöûa beân traùi cuûa hoäp thoaïi naøy thöïc chaát chính laø hoäp thoaïi Waypoint Default, cho
pheùp ta chænh söûa cheá ñoä hieån thò vaø caùc thieát laäp cuûa ñieåm ñöôïc choïn.

Hình 26. Hoäp thoaïi Select Waypoints
by Symbols



- Nöûa beân phaûi hoäp thoaïi naøy cho ta bieát caùc thoâng tin cuûa ñieåm ñöôïc choïn, bao goàm:

+ Latitude: vó ñoä

+ Longitude: kinh ñoä

+ Altitude: ñoä cao, löu yù laø khoâng phaûi maùy ñònh vò naøo cuõng löu giaù trò ñoä cao khi
löu ñieåm toaï ñoä.

+ Date: ngaøy thaùng naêm vaø giôø ñieåm toaï ñoä ñoù ñöôïc löu

+ Name: Teân cuûa ñieåm toaï ñoä.

+ Description: moâ taû ñieåm ñöôïc choïn. Ta coù theå choïn thoâng tin hieån thò trong oâ naøy
caùch nhaép chuoät vaøo muõi teân thaû xuoáng. Giaù trò maëc ñònh laø ngaøy ñieåm ñang choïn
ñöôïc löu.

Ta coù theå thay ñoåi taát caû caùc thoâng tin trong oâ naøy. Löu yù raèng khi thay ñoåi hai giaù trò
kinh ñoä/vó ñoä thì ñieåm ñoù seõ bò di chuyeån treân baûn ñoà töông öùng vôùi giaù trò môùi.

Xem thoâng tin cuûa ñöôøng ñi

Ta khoâng theå xem thoâng tin cuûa toaøn boä moät ñöôøng trong phaàn meàm naøy, maø chæ coù
theå xem thoâng tin cuûa töøng ñoaïn (ñöôøng thaúng giöõa hai ñieåm). Caùch thöïc hieän:

- Di chuyeån con troû chuoät laïi gaàn moät ñöôøng, ta seõ thaáy ñoaïn gaàn con troû chuoät nhaát seõ
hieän leân roõ hôn caùc ñoaïn khaùc.

- Nhaép chuoät phaûi thì hoäp thoaïi Edit Track (hình) seõ môû ra.

Hoäp thoaïi naøy cho ta bieát caùc thoâng tin sau:

Hình 26. Hoäp thoaïi Edit Waypoint - chænh söûa ñieåm.



- Trackpoint #1 vaø TrackPoint #2: cho ta bieát toaï ñoä cuøng ñoä cao cuûa ñieåm ñaàu vaø ñieåm
cuoái cuûa ñoaïn ñoù.

- Length: chieàu daøi cuûa ñoaïn ñöôïc choïn

- Bearing: höôùng cuûa ñoaïn ñöôïc choïn.

- Speed: toác ñoä di chuyeån treân ñoaïn ñoù, löu yù laø khoâng phaûi maùy ñònh vò naøo cuõng löu
thoâng tin naøy vaøo ñöôøng ñi.

- Date: ngaøy thaùng naêm vaø giôû di chuyeån treân ñoaïn ñoù.

- Track #: soá thöù töï cuûa ñöôøng ñi chöùa ñoaïn ñöôïc choïn.

- Segment #: soá thöù töï cuûa ñoaïn ñöôïc choïn trong ñöôøng ñi chöùa noù.

- Point: cho bieát toång soá ñieåm thuoäc ñöôøng ñi ñöôïc choïn.

- Time Interval: khoaûng thôøi gian di chuyeån treân ñoaïn ñoù.

- Total time: toång thôøi gian di chuyeån treân ñöôøng ñi chöùa ñoaïn ñoù.

- Tracklog Name: cho bieát teân ñöôøng ñi.

- Tracklog Style: cho pheùp ta choïn kieåu ñöôøng ñi maëc ñònh (nuùt Tracklog Default), hoaëc

choïn moät kieåu ñöôøng roài thieát laäp noù laøm kieåu maëc ñònh. Nuùt Scale môû hoäp thoaïi

Hình 27. Hoäp thoaïi Edit Track - chænh söûa ñöôøng ñi.



Scalable Tracklog cho pheùp ta choïn khoaûng giôùi haïn hieån thò ñöôøng ñi ñoù. Hai nuùt

Bring to Front vaø Send to Back cho pheùp ta ñöa ñöôøng ñang ñöôïc choïn leân

treân hay xuoáng döôùi caùc ñoái töôïng khaùc.

- Phaàn döôùi beân phaûi cuûa hoäp thoaïi naøy hoaøn toaøn gioáng vôùi hoäp thoaïi Select Tracklog
Style, cho pheùp ta choïn kieåu ñöôøng.

Xem thoâng tin cuûa loä trình

Ñeå xem thoâng tin cuûa moät loä trình, ta thöïc
hieän töông töï ñoái vôùi ñöôøng, töùc laø duøng coâng cuï
choïn vaø di chuyeån con troû chuoät ñeán gaàn moät
ñoaïn cuûa moät loä trình, ñoaïn ñoù hieän roõ leân, nhaép
chuoät phaûi thì hoäp thoaïi Edit Route (hình) môû ra,
cho ta bieát nhöõng thoâng tin sau:

- RoutePoint #1 vaø RoutePoint #2: yù nghóa
töông töï TrackPoint #1 vaø TrackPoint #1. Tuy
nhieân loä trình khaùc ñöôøng ñi ôû moät ñieåm laø noù
phaûi ñi qua caùc ñieåm ñaõ ñöôïc ñaët teân, neân
trong hai oâ treân khoâng hieän toaï ñoä maø laø teân
cuûa hai ñieåm ôû hai ñaàu ñoaïn ñöôïc choïn. Beân
phaûi hai oâ naøy coù nuùt leänh chænh söûa ñieåm toaï
ñoä cuûa ñoaïn ñang ñöôïc choïn.

- Caùc oâ Length, Bearing/North, Segment, vaø
Points coù yù nghóa töông töï nhö trong hoäp thoaïi
Edit Track.

- Route Name: cho bieát teân loä trình ñoù.

- Route #: cho bieát soá thöù töï cuûa loä trình ñang
choïn.

- Start vaø End: cho bieát ñieåm toaï ñoä ñaàu vaø cuoái
cuûa loä trình ñöôïc choïn.

Chænh söûa caùc ñoái töôïng treân baûn ñoà

Ta coù theå choïn moät/nhieàu ñoái töôïng treân baûn ñoà roài xoaù noù ñi baèng caùch nhaán phím
<Delete>. Nhö ñaõ trình baøy ôû phaàn treân, khi nhaép chuoät vaøo moät ñöôøng hay loä trình, chæ
coù ñoaïn gaàn con troû chuoät nhaát ñöôïc choïn. Muoán choïn toaøn boä moät ñöôøng ñi/loä trình ta
nhaép chuoät ñuùp vaøo noù.

Khi choïn moät ñoaïn treân moät ñöôøng ñi/loä trình, neáu ta nhaán phím <Delete> thì chæ coù
ñoaïn ñoù bò xoaù ñi, ñöôøng ñi hay loä trình ñoù bò caét ra laøm hai vaø trôû thaønh hai ñöôøng ñi hay
hai loä trình môùi.

Hình 28. Hoäp thoaïi Edit Route.



Ñeå veõ theâm moät ñieåm vaøo baûn ñoà, ta choïn nuùt Pencil Tool . Ta veõ theâm moät ñieåm
môùi baèng caùch nhaép chuoät treân baûn ñoà.

Ñeå veõ theâm moät ñöôøng ñi môùi ta duøng nuùt Handfree Drawing Tool hay nuùt
Continuous Line ñeå veõ baèng caùch reâ chuoät treân baûn ñoà.

Ñeå veõ theâm moät loä trình, ta duøng nuùt Create Routes . Nhö ta ñaõ bieát, loä trình laø
moät ñöôøng ñi qua caùc ñieåm ñaõ ñöôïc löu vaø coù teân, vì vaäy taïo moät loä trình môùi laø moät quaù
trình goàm hai böôùc:

- Böôùc 1: taïo ra caùc ñieåm maø loä trình saép veõ seõ ñi qua.

- Böôùc2: veõ ra loä trình môùi.

Cuï theå caùch thöïc hieän nhö sau:

- Nhaép chuoät choïn nuùt Create Routes.

- Di chuyeån chuoät trôû laïi baûn ñoà, nhaép chuoät laàn löôït ñeå taïo ra caùc ñieåm döï kieán loä trình
saép veõ seõ ñi qua. Caùc ñieåm naøy seõ ñöôïc chöông trình ñaët teân töï ñoäng, ta coù theå ñoåi teân
neáu muoán.

- Di chuyeån chuoät trôû laïi ñieåm baét ñaàu loä trình cho ñeán khi ñieåm baét ñaàu ñoù ñöôïc ñaùnh
daáu baèng moät voøng troøn bao quanh noù, giöõ phím chuoät traùi vaø reâ chuoät ñeán ñieåm thöù
hai roài thaû phím chuoät traùi ra, moät ñoaïn ñöôïc taïo thaønh. Tieáp tuïc giöõ phím chuoät traùi
treân ñieåm ñoù roài reâ chuoät ñeán ñieåm thöù ba vaø laïi thaû phím chuoät traùi ra,... Thöïc hieän
laàn löôït cho ñeán khi taïo xong loä trình thì thoâi.

Löu yù: neáu ta coù yù ñònh taïo loä trình ñeå sau naøy taûi vaøo maùy ñònh vò söû duïng, thì caàn löu
yù laø soá löôïng ñieåm cho pheùp cuûa moät loä trình laø coù giôùi haïn. Soá löôïng loä trình cuõng giôùi
haïn. Ví duï nhö ñoái vôùi caùc maùy ñònh vò thoâng thöôøng cuûa haõng Garmin, soá ñieåm toái ña treân
moät loä trình laø 30 vaø maùy ñònh vò chæ chöùa ñöôïc toái ña 20 loä trình.

Ñaêng kyù aûnh queùt vaøo chöông trình GPS TrackMaker

Moät trong nhöõng tính chaát ñaëc saéc nhaát cuûa phaàn meàm naøy chính laø khaû naêng môû aûnh
queùt vaøo cöûa soå baûn ñoà vaø cho pheùp ñaêng kyù toaï ñoä cho aûnh queùt. Ñeå thöïc hieän ñieàu naøy,
ta laøm caùc böôùc sau:

- Töø menu chính choïn Tools > Insert Map Image hoaëc choïn nhanh baèng caùch nhaép chuoät

vaøo nuùt Insert Map Image treân thanh coâng cuï Main. Hoäp thoaïi Open Map Image

môû ra.

- Choïn ñònh daïng taäp tin aûnh caàn môû trong oâ Files of Type. GPS TrackMaker hoã trôï caùc
ñònh daïng aûnh sau: Compuserve Graphics Interchange (*.gif), JPEG Compliant (*.jpeg,
*.jpe, *.jpg), Windows and OS/2 Bitmap (*.bmp), Windows Metafile (*.wmf),
Windows Enhance Metafile (*.emf), Windows Icon (*.ico).

- Choïn thö muïc chöùa aûnh caàn môû trong oâ Look in vaø choïn aûnh caàn môû trong danh saùch



hieän leân trong oâ phía döôùi.

- Choïn Open.

AÛnh ñaõ choïn seõ ñöôïc môû trong cöûa soå baûn ñoà.

Khi môùi môû moät aûnh ra, aûnh naøy chöa ñöôïc ñaêng kyù toaï ñoä, vì theá noù hieån thò khoâng

ñuùng vò trí. Muoán aûnh hieån thò ñuùng vò trí, ta phaûi thöïc hieän ñaêng kyù toaï ñoä cho aûnh. GPS
TrackMaker ñaêng kyù aûnh theo cô cheá töông töï AutoCAD, coù nghóa laø noù chæ söû duïng hai
ñieåm khoáng cheá ôû goùc treân beân traùi vaø goùc döôùi beân phaûi.
Nhö vaäy ta phaûi bieát toaï ñoä cuûa hai ñieåm naøy. Tieán haønh
ñaêng kyù nhö sau:

- Choïn Tools > Map Image Properties hay choïn nhanh
baèng caùch nhaép chuoät vaøo nuùt Map Image Properties

treân thanh coâng cuï Main. Hoäp thoaïi Image
Properties môû ra (hình).

- Naïp toaï ñoä goùc treân traùi cuûa aûnh vaøo hai oâ Latitude (vó ñoä)
vaø Longtitude (kinh ñoä) trong phaàn Point #1. Toaï ñoä naïp vaøo hai oâ naøy laø ñoä thaäp phaân.
Töông töï, naïp toaï ñoä goùc döôùi beân phaûi cuûa aûnh vaøo phaàn Point #2.

- Sau khi naïp xong toaï ñoä, nuùt leänh Recalibrate Image hieän roõ leân. Ta nhaép chuoät vaøo

Hình 29. Hoäp thoaïi Image Properties - Ñieàu chænh thuoäc tính aûnh.

Hình 30. Thoâng baùo
ñaêng kyù aûnh thaønh coâng.



nuùt naøy. Moät hoäp thoaïi hieän ra (hình) thoâng baùo vieäc ñaêng kyù aûnh thaønh coâng.

- Nhaép chuoät choïn OK ñeå ñoùng hoäp thoaïi naøy laïi.

- Nhaép chuoät vaøo nuùt Exit ñeå keát thuùc vieäc ñaêng kyù aûnh.

AÛnh queùt seõ ñöôïc di chuyeån vaø thay ñoåi tyû
teä theo ñuùng vôùi toaï ñoä hai ñieåm ñaõ ñaêng kyù.

Trong phöông phaùp ñaêng kyù aûnh queùt nhö
theá naøy, ta phaûi bieát toaï ñoä hai meùp taän cuøng
cuûa aûnh queùt. Ñieàu naøy thöôøng khoù xaùc ñònh
vì thoâng thöôøng moät tôø baûn ñoà giaáy khi queùt
vaøo coù caû phaàn meùp baûn ñoà vaø vuøng naøy
khoâng xaùc ñònh ñöôïc toaï ñoä. Ñeå giaûi quyeát
ñieàu naøy, ta coù moät nuùt leänh ñeå thöïc hieän ñaêng
kyù theo hai ñieåm baát kyø trong baûn ñoà ñaõ bieát
toaï ñoä. Caùch thöïc hieän nhö sau:

- Môû aûnh queùt ra baèng leänh Tools > Insert Map Image nhö bình thöôøng.

- Sau khi aûnh queùt ñaõ môû ra, nhaép chuoät vaøo nuùt Map Adjust Tool treân thanh coâng

cuï Main.

- Khi di chuyeån chuoät trôû laïi baûn ñoà, ngay taïi vò trí con troû chuoät hieän leân hai ñöôøng vuoâng
goùc maøu xanh lô.

- Nhaép chuoät vaøo moät ñieåm ñaõ bieát toaï ñoä, hoäp thoaïi Map Adjust Tool môû ra (hình).

- Naïp toaï ñoä cho ñieåm vöøa nhaép chuoät trong hai oâ Latitude (vó ñoä) vaø Longitude (kinh
ñoä), tính baèng ñoä thaäp phaân.

- Thöïc hieän töông töï cho moät ñieåm khaùc ñaõ bieát toaï ñoä.

Khi ñaêng kyù cho baûn ñoà theo phöông phaùp naøy, ta caàn choïn hai ñieåm caùch caøng xa
nhau caøng toát. Toát nhaát laø choïn hai ñieåm naèm treân ñöôøng cheùo cuûa tôø baûn ñoà.

Khi ñaêng kyù baûn ñoà laø aûnh queùt trong öùng duïng naøy ta löu yù laø tôø baûn ñoà queùt chæ neân
thuoäc moät khu vöïc nhoû ñeå ñaûm baûo sai soá thaáp. Do trong phöông phaùp naøy chæ söû duïng hai
ñieåm khoáng cheá neân baûn ñoà ñöôïc ñaêng kyù theo maët phaúng (heä toaï ñoä Descartes). Neáu ñaêng
kyù vaøo moät tôû baûn ñoà bao truøm moät khu vöïc roäng, sai soá seõ taêng leân.

Ñeå loaïi moät baûn ñoà queùt ñaõ ñaêng kyù ra khoûi baûn ñoà, ta thöïc hieän nhö sau:

- Choïn Tools > Map Image Properties ñeå môû hoäp thoaïi Image Properties môû ra.

- Nhaép chuoät vaøo nuùt Remove ñeå loaïi aûnh queùt ñaõ ñaêng kyù ra khoûi baûn ñoà.

Hình 31. Hoäp thoaïi Map Adjust Tool.




